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nDo2 lets you create normal maps straight in Photoshop. This means you get to create 

normals with all the tools you already know, while keeping your pipeline clean. nDo2 

brings multiple normal mapping disciplines together, and presents a rapid workflow 

skipping the 3D detour. It can substitute modeling pipelines, or act as a fast and powerful 

complement to basic high-poly baking. Hard-surface and organic normals become easy. 

Luckily, nDo2 does more than just normal maps. Powerful AO, displacement, diffuse, 

specular and cavity generators are at your disposal, tweakable in real-time and with 16-

bit precision. Thanks to what can only be witch craft, rich 3D can be derived from super 

simple cavity doodles. To top it off, nDo2 extends PS with a 3D previewer, allowing you 

to preview tweaks without ever leaving Photoshop.   

In this tutorial, we’ll learn how to create custom normals from photos and hand-painted 

bases, with results indistinguishable from careful sculpting. We’ll also go through how to 

create hard-surface normals with speeds not enabled by traditional 3D workflows. Lastly, 

we’ll see how nDo2 works as a complement to high-poly modeling, for significantly 

speeding up detail work. First, let’s get to know the UI basics! 
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nDo2 consists of two main components – a small, flexible UI, and a floating 3D 

previewer. It reacts and transforms according to everything you do inside of Photoshop -

- it’s all about letting you create as much as possible with as few UI interruptions as 

possible. The previewer is designed to boost turnaround, never forcing you to leave 

Photoshop when studying your results in 3D. It's as simple as can be -- your mesh, fully 

interactive, smack on the screen. 

nDo2 morphs its UI according to what you do in 

Photoshop. For instance, when you make a 

selection, the UI will present you with options to 

convert it to normal. Select a group of normals, and 

a quick-tweaking interface will appear instead. No 

one likes digging through menus, so nDo2 provides 

you with what you need, when you need it. 

It enables simple tweaking of many layers at once, 

and advanced tweaking of one layer at a time.  

 All sliders in nDo2 are snappable -- press Ctrl for regular snapping and hold Shift Tip 1:

for double the snap threshold, or Alt for half. 

 The nDo2 UI is completely compressible. To compress, double-click Tip 2:

the top-left N icon, and nDo2 will instantly turn into a small rectangular 

blob, hiding the previewer in the same instant. The same effect can be 

achieved by dragging either of the window’s corners to size it down. To restore the UI, 

double click the N again. 
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The 3D previewer is basically a fully interactive switchable mesh, which hovers in 

Photoshop. Just like the main UI, it adapts to what you are doing in Photoshop. When 

you tweak your maps, it instantly updates, and when switching between normal maps it 

automatically loads the current project. Also, with its relief mapper, you can always 

preview your normals in full 3D. 

 

The previewer is full of options – simply right click it to open its context menu. The 

previewer context menu lets you tweak material rendering settings, hook up maps, 

toggle the backdrop, and select which meshes and light presets to display.  

 Texture maps can be toggled in three ways: hidden, killed, and solo. Hiding the Tip 1:

map will temporarily disable the texture, whereas killing it will completely toggle off all 

reflectivity. The solo mode lets you preview pure, unlit texture information. 
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 Map hooking enables maps to be auto-reloaded in the previewer when saved. To Tip 2:

hook up a map, first select the desired Photoshop document, then press the desired link 

button. Now, whenever you save the document, the changes will appear in the pre-

viewer. Note that if the document has not yet been saved to disk, it won’t auto-reload. 

As you tweak any maps that have been generated with nDo2, the previewer will 

automatically render those updates. As you tweak your height map you will see the 

previewer reflecting your changes. nDo2 uses a Relief mapping shader to render 3D from 

height, similar to what is found in many real-time technologies, such as CryEngine3. Just 

like with all other map type values, you can tweak and toggle the height value through 

the previewer context menu. 

 To switch the preview mesh, click on any of the mesh icons to make it the active Tip 3:

one, or press keys 1-4. To load a custom mesh, click the right-most mesh icon. Note that 

nDo2 will auto-triangulate any non-triangulated meshes.  

 To change the general tiling factor, simply drag the bottom-most tiling slider. Note Tip 4:

that all text box values can be overridden, extending the default range.  

 Sometimes it's nice to preview the mesh and nothing else. This is what the Tip 5:

backdrop is for. Enabling it dims the screen and shows nothing but the mesh. 
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All normals in this example scene have been done with nDo2. It contains tiling hard-

surface normals, and basic high-poly normals combined with details made using nDo2. In 

most cases, modeling can be skipped entirely, speeding up the workflow immensely. In 

this simple example we’ll look into how to create normals in the vein of this scene. 

So, let’s break down how to create a tiling hard-surface normal. We’ll use a variety of 

creation techniques to create a few basic shapes, and then convert those shapes into 

normal layers. Then, we’ll learn a few tweaking tricks for pumping out volume. Lastly, 

we’ll learn about sculpting and zipping, and top it all off with height, AO, diffuse and 

specular maps. 
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The above normal may look complex, but it’s actually just 6 nDo2 layers. The 3D is 

calculated automatically from the hard-surface normal. All in all the normal was created 

in about 5 minutes, and most materials were generated from the normal. 

STEP 1: NEW NORMAL DOCUMENT 

Let’s begin by creating a new 512x512 normal document. Just 

press the NEW NORMAL button (shows up if no docs are open), 

and you're good to go. You can also press File > New normal 

map or Ctrl+N. Note that a normal document is also 

automatically created whenever something is converted to 

normal for the first time. 

 You can customize the normal channel configuration by going to File > Preferences Tip 1:

> Flip normal channels. For instance, checking Flip Y will make your normals compatible 

with UDK. 

STEP 2: CONVERTING TO NORMAL 

nDo2 lets you use virtually any tool in Photoshop to create your normal, 

from selections and vectors, to photographs and hand-painted details. 

And once a normal has been generated, it's always possible to re-sculpt its 

original source, whether it be a vector shape, text or art layer. 

Whenever a conversion input is detected, nDo2 will display a big CONVERT button. 
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I’ll create the first normal using a simple selection -- this is most 

likely the quickest way you can create a hard-surface normal. 

Simply design your selection using any of the lasso, polygonal or 

marquee tools, click the big CONVERT button and you've got a 

normal. 

Drag the selection so that it goes all the way down to the bottom 

of the canvas. Notice how a NO EDGE BEVEL option appears – 

toggle this, and the normal will not get any bevels near the 

canvas edges. 

 

STEP 3: TWEAKING THE NORMAL 

nDo2 comes with more than 50 unique sliders and normal 

tweaking options, letting you experiment with your normals 

in endless ways. The moment a new normal has been created a 

tweaking interface will show up. Let’s play around with it! 

The top row of drop-downs lets you 

combine and choose between a range 

of normal Shapes, Bevels and more. 

The style I’m going for with this normal 

is a door frame kind of bevel. I want it 

to be hard and crisp, so I set its shape to 

Chiseled Shallow. I want a furrowed 

look, so I set the bevel to Groove. 

I’ll also change the Slant to Down, making the normal point 

inwards. To finally get the multi-beveled look of a door frame, I’ll 

go ahead and set the Curve to something funky like Terraced. 
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The sliders enable fine-tuning of more general settings, such 

as Size, Softness and Opacity. For this normal, I’ve set the 

size to 32 pixels, and left the rest of the sliders untweaked. 

Depth and Contrast are similar to each other -- low values 

produce low intensity, but the difference is the depth slider 

also relaxes the normal bevel at low values. The Falloff 

controls the tightness of the normal bevel -- low values 

result in a sharper curve, high values yield a smoother, more 

relaxed curve. Planefill controls the opacity of the part of 

the normal which has zero angle (i.e. anything blue). 

 Curves offer a great simple way to add to the complexity of your normal, by Tip 1:

transforming the slope of the bevel. They also reduce the need for combining multiple 

normals to produce multi-faceted bevels. You can achieve some pretty crazy results with 

curves, like in this simple but extreme example: 

 

Look past the horrifically nonsensical dev-art – this example simply aims to show that 

crazy volume can be easily achieved from just 6 very basic layer masks. It is NOT art! :D 



nDo2 Workflow Walkthrough 

 nDo2 WORKFLOW WALKTHROUGH 

   
nDo2 Workflow Walkthrough 

STEP 4: ADDING SCULPTED NORMALS 

The sculpt mode lets you use the full capacity of Photoshop paint your normal in 

real-time using any PS brushes, and lets you edit the source of a normal at any 

time (such as the vector that was used to create it). Sculpting lets you preview 

and tweak your normal properties as your normal is being painted. It’s just as 

easy to sculpt organic details as it is sculpting hard-surface stuff. The normal 

settings of a layer can be tweaked at any time, even after the normal has been 

painted. 

For our next normal, I want to create a new sculpt layer from scratch. It should 

be a bulky and tileable top trim, with a bit of carved hard-surface detail.  

Creating an empty sculpt layer from scratch can 

be done by either pressing Ctrl+Shift+N, or 

selecting Edit > New Sculpt Layer. Regular sculpt 

layers will produce bevels near document 

borders – to create a sculpt layer with no border 

bevels, instead select Edit > New Edgeless Sculpt Layer. This is important when painting 

tileable details, so let’s create one of these! 

To create the trim base, I make a 

selection which I transform to 

extend the canvas borders. I then fill 

the selection with a random color, 

and set the normal Size to 16 pixels. 

I’ll also set the shape to Chiseled Shallow and Anti-Alias to 1. Next I want to sculpt some 

big carved details, so I select the eraser tool -- add a layer mask instead if you want the 

original pixels intact. With the eraser brush radius set to 1px, I erase two straight lines 

near the top of the normal, to carve the bevel. I use the eraser, and not a black brush – 

when sculpting, brush color 

does not matter. To view the 

latest sculpt layer edits in 

the previewer, simply click 

the refresh icon. 

To exit the sculpt mode, click 

the SCULPT button. This is 

necessary to ensure that the 

normal gets the correct colors. 

To convert any normal element to a sculpt layer again, simply toggle the SCULPT button, 

and you’re ready to start painting. Untoggling turns the sculpt layer back into a normal. 
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STEP 5: REPEAT UNTIL DONE 

You now know the very basics of creating nDo2 

normals – it’s all downhill from here! 

 I’ve created the next normal from a Panels:

masked solid color layer. I’ve used a Chiseled 

Shallow shape, an Emboss bevel, and set the 

size to 2 pixels. 

 Now that all basic shapes are in place, Gratings:

it’s time for some detail work. Next I’ll add 

some gratings, which I’ve created using a 

standard art layer. Simply create a new layer, 

paint, and generate. Bright colors will produce 

an opaque, upward-pointing normal, while dark 

colors and transparency will both point inwards. 

Again, I’ve set the shape to Chiseled Shallow (optimal for sharp shapes), the size to 1 

With nDo2, you can blend normals together with any pixel, and the Blend to Hard light. 

blend mode Photoshop has to offer. By setting the blend to Hard light instead of Overlay, 

the normal will really pop against the underlying normals. 

 Next I want to add some detail to the top trim, this time using vectors. nDo2 Lights:

supports any kind of Photoshop vector, including shapes, closed paths, open paths and 

text vectors. Vectors can always be re-tweaked by entering the sculpt mode, and can be 

sculpted further using an additional layer mask.  

I’ll create a simple path vector. I’ll make sure to close 

the path by connecting its first and last anchor points. 

If I leave the vector open, nDo2 will create a normal 

along the path using the currently selected brush. This 

is perfect for creating organic details, such 

as cables and welding seems. When I’ve converted to normal, I 

set the shape to Chiseled Shallow, the bevel to Emboss, the slant 

to Down, the curve to Ring, the blend to Overlay, and finally the 

size to 4 pixels. 

 For the final normal, I’ll create a regular sculpt layer. Final details:

I choose an Emboss bevel, set the size to 2 pixels, and select an 

Overlay blend. I sculpt some simple door details and call it done! 
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Tip 1: Once a normal layer is finished, zip it! This is done by 

toggling the ZIP button. It is a completely non-destructive 

process, and greatly boosts performance. Also, file sizes drop 

significantly, speeding up both saving & loading. A normal can 

be unzipped at any time. 

 You can rotate and transform any of your generated Tip 2:

normals, and the normal recalculates itself in real-time. Try it 

out! 

 To transfer one the style of one normal to another, use Tip 3:

the Copy & Paste buttons. You can also override the default 

normal style with the Make Default button.  

 When sculpting, you have more control over your normal Tip 4:

than through standard tweaking. For instance, you can apply 

Photoshop filters (such as blurs and distortions) or advanced 

transformations (warp transforms, liquify etc.).  

 

Quickly generating high-quality base maps is an important part of efficient material 

creation. Luckily, nDo2 comes with a set of powerful and flexible map converters. Normal 

maps can be converted to Ambient Occlusion, Displacement (organic and hard-surface), 

Diffuse, Specular and Cavity. All maps can be generated with 16 bit precision and allow 

for real-time tweaking, no re-baking required. All converters can be accessed at any time 

by clicking the Convert… menu item. 
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You’ll notice a few more maps than just normals can serve as input. The converter UI lets 

you choose between three input types, namely Normal, Height & Cavity. This offers a 

great deal of flexibility (16 conversion options in total), letting you do things like 

converting height to AO, or better yet, hand-painted cavity maps to normal. 

It is possible to generate any combination of maps at once (hold Ctrl to select multiple), 

and batching multiple inputs is supported. Here’s the result of converting our new 

normal to tileable Ambient Occlusion, Displacement, Diffuse and Specular in one go: 

 

Base materials like these are a necessity, and make texture creation a little less 

cumbersome. All maps generated by nDo2 can be tweaked in great control. Let’s learn 

more about what can be done with each map type! 

 

nDo2 offers a powerful Ambient Occlusion generator. It inputs any normal, and rapidly 

outputs robust AO. The look and feel can be tweaked and previewed in real-time without 

re-baking, allowing for advanced and efficient customization. Rendering AO from normal 

is extremely efficient, as all it cares about is pixels, and not hundreds of millions of 

polygons. Not having to sit through eternal baking times just because of a minor tweak 

can be quite a joyous experience! 

To generate the AO map, click the Convert… menu item. As the UI pops up, you’ll see 

that the AO option is selected by default, so just press the Active Doc button, and your 

Ambient Occlusion will be ready in a few seconds.  



nDo2 Workflow Walkthrough 

 nDo2 WORKFLOW WALKTHROUGH 

   
nDo2 Workflow Walkthrough 

 

When the conversion is done, you 

will now see your AO applied in the 

previewer -- you can tweak its 

influence on both the diffuse and 

specular map via the previewer 

context menu. You’ll also see a 

small tweaking interface – go 

ahead and drag the sliders around! The sliders allow you to quickly balance the opacities 

of three different AO elements, namely the Fine, Medium and Large shadows. 

Digging a little deeper, each AO element has a variety 

of tweaking options. The individually tweakable 

settings are Size, Softness, Opacity, Curve and Blend. 

To access these settings, click one of the AO elements 

to dive into its advanced tweaking UI. Alternatively, 

right click the element, and the advanced tweaking UI 

will appear in the form of a pop-up.  
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 The best results are generally achieved by setting the Softness to at least 1-2 times Tip 1:

larger than the Size. A large size and weak softness tend to result in more unnatural-

looking shadows. 

 It’s possible to extend your AO with additional detail, for instance for adding a Tip 2:

layer of larger shadows. To add more layers of detail to the AO map, simply select any 

AO element (“Fine Shadow”, for instance), hover over the nDo2 UI and press CTRL+D. 

You’ll now have an extra layer of AO, ready to tweak! 

 

Previewing your normal in full 3D while creating it in 2D is quite a satisfying experience, 

and gives you a more solid feel of the design you are creating.  

nDo2 is equally as much a fully-fledged displacement map creator as it is a normal map 

creator. Due to the reliability of the nDo2 displacement creators, designing an advanced 

3D material simply becomes a matter of designing a normal map. Displacement mapping 

has many powerful applications both in offline and real-time rendering. One real-time 

application is hardware tessellation, as demonstrated in this basic UDK example: 

 

Normal maps are significantly easier to read than height maps, thus making them much 

easier to design. There is no need to think in the third dimension – instead, this is 

automatically taken care of by the height converter. 
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nDo2 includes two displacement converters – All-round and Hard-Surface. Where the 

All-round displacement generator works for any type of normal map and is biased 

towards organic normals, the Hard-Surface generator yields non-biased, perfectly plane 

height -- provided that the normal is in nDo2 format. You’ll therefore notice the Hard-

surface option is only enabled when working with nDo2 normals – i.e. multilayered 

normal maps created entirely in nDo2. 

To generate a Hard-Surface height map, we first need to make sure our nDo2 normal 

map is selected. Then, open up the Convert… interface and select the Hard-Surface 

option. nDo2 will now quickly run through your entire PSD and individually convert each 

normal element to height. Note that you can manually bias the height of specific layers 

by modifying the normal elements’ Z-factor sliders before converting to height. 

 

To generate an All-round displacement map, open up the Convert… window and select 

All-round. As the map has been generated, you will be presented with a bunch of sliders 

for controlling of a range of height frequencies. The topmost slider controls all 

frequencies at once, and distributes them according to the selected Distribution curve. 

The standard Slope curve provides an accurate blend of fine and large details, whereas 

the Gaussian curve lets you pump out 

more detail. 

One of the most powerful applications of 

height maps in real-time rendering is 

hardware tessellation. nDo2 in combination 

with tools such as UDK makes tessellation 

easier than ever before. 
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All normals and displacement maps in this UDK scene have been created with nDo2. 

Real-time tessellation is at work, really bringing the streets to life. Next, we’ll learn how 

to create just such normals! You’ll find creating organic stuff is easier than a breeze. 

 

Those familiar with traditional photo-to-normal 

conversion tools will easily grasp nDo2’s photo-

normal creation process. When digging a little 

deeper, you’ll soon learn it is fundamentally 

different in terms of creative control and output. 

nDo2 comes with a number of material presets. 

These presets are designed to reconstruct 

extremely rich, material specific normals from 

diffuse maps. The more advanced they are, the 

longer they will take to process – there is no limit 

to how much detail a preset can hold. 
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nDo2’s normal creation engine makes it easy to achieve clear-cut separation between 

crisp details and defined volume, enabling results that previously had to be sculpted. 

 

Converting a photo or hand-painted base to normal is super easy. Simply click on 

Presets… and the preset browser will appear. You’ll find a tree view of the preset 

categories available. General presets aim to provide a vanilla blend of volume and detail, 

whereas Material presets aim to accurately recreate certain surface types.  

As indicated by the three large buttons, you can generate normals from the clipboard, 

the active document in Photoshop, or from file (selecting multiple files result in batch 

conversion). If you already have your diffuse base opened and active in Photoshop, press 

the Active Doc button. I’ve selected the “Flat Cliff” preset for the example below. 
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When nDo2 has finished, you’re presented with a simple 

tweaking interface for fine-tuning the characteristics of 

your normal. Play around with the sliders until you are 

happy with the result – fooling around with these sliders 

can have a dramatic effect on your normal map. 

 

It’s easy to create your own preset from scratch. Start off by converting 

your diffuse to a single normal, and tweak its settings to bring out basic 

details. Then simply duplicate that normal (Ctrl+D), set it to overlay and 

tweak it to bring out new characteristics. Keep duplicating and tweaking 

until you’ve reached the perfect blend of details and volumes tailored to 

your diffuse. There is really no limit to how complex your normal map 

can be. I usually work my way up from small to large detail, but any 

order will do. Combining the vast amount of tweaking options lets you 

recreate pretty much any volume. 

When you’re done, simply group the normals, name the group, and hit 

“Save” in the Presets… UI – you now have a custom preset to reuse at 

any time! 

 When creating new presets, I always start off with a 200x200 crop Tip 1:

of my diffuse, instead of the full-resolution original. This is because I 

want tweaking to be as instant as possible when experimenting. I try to 

pick a part of the diffuse that contains a varied blend of details and 

volumes, representative of the diffuse in full.  

When I’m done building the normal, I save the preset and try it out on 

my original diffuse. If I spot things to improve, I go back to tweaking the 

cropped normal and repeat until I’m satisfied. 
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Here’s one of the more crazy bits of nDo2. In nDo2, displacement maps are computed by 

first converting a normal map to cavity, and then generating displacement from the 

cavity information. This means it’s fully possible to generate height maps straight from 

cavity. As we can easily convert height to normal, reasonably, we can create normal 

information straight from a cavity map. This actually means we can just as well paint our 

own cavity maps, and directly turn them into normal maps. Mother of god… 

 

By looking at a cavity map, we almost instantly visualize how the original normal would 

look. Unlike normals, it is extremely simple to paint -- learning how to emulate cavity 

thus opens up powerful new normal creation possibilities. 

To paint a custom cavity map, it helps to keep in mind how a real one works. Cavity maps 

hold convex and concave details, coloring any outward-bulging edges white, and any 

inward-hollowed edges black. Any constant slopes or flat surfaces turn into plane grey – 

thus I start off by creating a new document, filling it with a medium gray. 

In the simplest of cases, I create two layers – one for black cavities, and one for white 

convexities. For simple stuff, I usually go with a 2-3px soft brush with 10-70% fill opacity, 

and only use 100% black and white colors. I use low-to-medium intensities as cavity 

maps generally are not extreme in contrast. Note that painting with a too wide or 

intense brush will result in an unnatural cavity map, and thus probably a funky normal – I 

urge you to experiment though! Start off with a few simple tests to get acquainted with 

the basic cavity-to-normal logic, and go from there! 
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As a final example, all normals in this scene are created with nDo2. Here the tool has 

been used extensively, as the scene holds tiling hard-surface normals, photo-generated 

normals, and basic high-poly normals combined with details made using nDo2.  


